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ABSTARCT: 

In this study, first, and thermal analyzes are 

being investigated in the traditional diesel 

piston (uncut) Made design silicon 

aluminum alloy 1 and 2 design parameters. 

Second, the thermal analysis Made in the 

piston, coated with zirconium through the 

use of commercial law, namely ANSYS. 

And I investigated the effects of coating on 

the thermal behavior of the pistons. Finite 

element analysis is Programs using 

computer-aided design. The main objective 

is to achieve and analysis Thermal stress 

distribution of the piston in the event of an 

actual engine during the combustion 

process. To illustrate this thesis network 

optimization technique using the finite 

element analysis to predict the sensitive 

region of high pressure On race. In this 

work, the focus is on the study of the 

thermal behavior of functionally Classified 

coatings obtained through the use of 

commercial laws, aluminum and zirconium 

ANSYS Piston coated aluminum surfaces. 

This analysis is to reduce the pressure of the 

concentration of the upper limbs Any of the 

piston (piston ring / piston and Ras Tanura 

and how much). Using NX design / 

computer assisted Katia The software 

structural model developed piston. 

Moreover, finite element analysis Using 

computer simulation software with the help 

of ANSYS. 

INTRODUCTION:  

Functionally graded materials are of great 

interest due to the above, for example, 

corrosion and erosion and oxidation 

resistance, high hardness, chemical and 

thermal properties at cryogenic temperature 

and high stability. These characteristics 

make them useful for many applications 

including thermal barrier coating (TBC) on 

metal substrates are used at high 

temperatures in the fields of aviation and 

space, especially for thermal protection of 

components in gas turbines and engines 

diesel. It has been successfully applied 

thermal barrier coating inside Combustion 

engine, in particular the combustion 

chamber in order to simulate adiabatic 

changes. It is not only to reduce the targets 
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in the cylinder heat Rejected and the 

protection of the basic thermal fatigue of 

metal surfaces, but also A possible reduction 

of emissions Engine braking and fuel 

consumption. tuberculosis application 

reduces heat loss from the engine cooling 

jacket through Of the exposed surface of 

heat transfer, such as the cylinder liner, the 

piston The crown of the piston rings. The 

isolation of the combustion chamber with 

ceramic Coating affects the combustion 

process, and thus performance and 

characteristics of the exhaust emissions of 

engines improvement. On the other hand, 

The desire to increase the thermal efficiency 

or reduce fuel consumption engines Lead to 

the adoption of higher compression ratios, 

especially for diesel engines, Decreased heat 

removal cylinder. Increased because each of 

these factors materials used mechanical and 

thermal stresses in the combustion chamber 

Tuberculosis application to the surfaces of 

these components improves the durability of 

high temperature by reducing the heat and 

reduce the degree of heat transfer of the base 

metal. Typical TBCs exfoliation of the top 

layer of the layer ceramic bonding failure. 

There are many factors that affect the 

overall performance of the paint, coating 

and cause landslides. However it is 

determined oxidation and thermal mismatch 

where the two main factors affecting the life 

of the paint system. Painting is impermeable 

to liquids and gases in the atmosphere, 

leading to oxidation of the bond coat and 

coating detachment. He has been using 

functionally graded coatings and to reduce 

impact of mismatch. Therefore, interfaces 

pressure and thermal expansion are an 

alternative approach to conventional coating 

thermal barrier. In this project, and are the 

main focus in the study of the thermal 

behavior functionally graded coatings 

obtained using commercial law put, ANSYS 

on aluminum and steel pistons and results 

with numerical and experimental work was 

verified. 

LITERATURE REVIEW: 

Thermal behavior of functionally graded 

coatings on AlSi and steel piston materials 

were investigated by means of commercial 

code, namely ANSYS. Thermal  analysis  

were  employed  to  deposit  metallic,  

cermets  and  ceramic powders  such  as  

NiCrAl,  NiCrAl+MgZrO3  and  MgZrO3  

on  the  substrate.  The numerical results of 

AlSi and steel pistons were compared with 

each other. The maximum  surface  

temperature  of  coated  AlSi  and  coated  

steel  piston  were compared with their 

corresponding uncoated piston. The heat 

resistance of each piston was compared.  The 
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resistance of the coated piston was found 

more than the uncoated aluminium piston 

by 14.5%. The resistance of the piston was 

found more than uncoated steel piston by 

11.3%. The coated piston yields 

comparatively less wear wit uncoated piston. 

This is one of the first few papers that deal 

with studies for nanostructure coatings. In 

this paper three different applications were 

discussed. Conventional air  plasma  spray  

of  nano  crystalline  alumina-titania  ware  

coatings  for  turbine applications was 

studied. Finally a brief mention of recent 

progress in spraying dense materials for use 

a standalone ceramics is been studied. Also 

the various coating thickness on the 

component were discussed.  

 INTRODUCTION TO FINITE 

ELEMENT ANALYSIS 

Methods to solve real time engineering 

problems 

Any engineering problem can be solved 

using the 3 methods mentioned below 

1) Analytical Method 

2) Numerical Method  

3) Experimental method 

Analytical methods:  It is a systematic 

procedure or technique used to break down 

material into its component parts so that its 

organizational structure can be understood 

and its chemical or physical composition can 

be determined easily. They provide closed 

form exact solutions to the mathematical 

model of engineering problems. They can be 

used only if the geometry, loading and 

boundary conditions of the problem are 

simple. Integration methods and other 

analytical solution methods of differential 

equations are the examples of the analytical 

methods. 

Numerical Methods:  

A method to solve mathematical 

equations approximately is called the 

numerical method. Basically numerical 

method transforms the 

mathematical problem into such a form that 

it can be solved by a simple arithmetic 

operation. They provide discrete form or 

approximate solution to the mathematical 

model of engineering problems. They can be 

used to solve the problems with relatively 

complex geometry, loading and boundary 

conditions. In particular finite elements can 

represent structures of arbitrarily complex 

geometry. Examples of few numerical 

methods are Finite Difference Method, 

Finite Element Method, Boundary Element 

Method, etc. As the numerical method deals 

with a lot of calculation, the technique 

would be an effective tool when it is 

employed in combination with computer. 
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Experimental methods:  

The experimental method is usually taken to 

be the most scientific of all methods, the 

'method of choice'.  The main problem with 

all the non-experimental methods is lack of 

control over the situation.  The experimental 

method is a means of trying to overcome 

this problem.  The experiment is sometimes 

described as the cornerstone of psychology: 

This is partly due to the central role 

experiments play in many of the physical 

sciences and also to psychology's historical 

view of itself as a science.  A considerable 

amount of psychological research uses the 

experimental method.  

 

METHODOLOGY: 

PISTON 

A piston is a component of reciprocating 

engines, pumps and gas compressors. It is 

located in a cylinder and is made gas-tight 

by piston rings. In an engine, its purpose is 

to transfer force from expanding gas in the 

cylinder to the crankshaft via a piston rod 

and/or connecting rod. In a pump, the 

function is reversed and force is transferred 

from the crankshaft to the piston for the 

purpose of compressing or ejecting the fluid 

in the cylinder. In some engines, the piston 

also acts as a valve by covering and 

uncovering ports in the cylinder wall.  

Main Components of diesel engine 

(1) Exhaust camshaft,  

(2) Crankshaft,  

(3) Water jacket for coolant flow,  

(4) Intake camshaft,  

(5) Spark plug, 

(6) Valves,  

(7) Piston,  

(8) Connecting rod,  

(9) Crankshaft,  

(10) Water jacket for coolant flow.  

 

INTERNAL COMBUSTION ENGINES  

 

There are two ways that an internal 

combustion piston engine can transform 

combustion into motive power: the two-

stroke cycle and the four-stroke cycle. A 

single-cylinder two-stroke engine produces 

power every crankshaft revolution, while a 

single-cylinder four-stroke engine produces 

power once every two revolutions. Older 

designs of small two-stroke engines 

produced more pollution than four- stroke 

engines. However, modern two-stroke 

designs, like the Vespa ET2 Injection utilise 

fuel-injection and are as clean as four-

strokes. Large diesel two-stroke engines, as 

used in ships and locomotives, have always 

used fuel-injection and produce low 

emissions 
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.  

One of the biggest internal combustion 

engines in the world, the wartsila sulzer 

RTA96-C is a two-stroke; it is bigger than 

most two-storey houses, has pistons nearly 1 

meter in diameter and is one of the most 

efficient mobile engines in existence. In 

theory, a four-stroke engine has to be larger 

than a two-stroke engine to produce an 

equivalent amount of power. Two-stroke  

engines  are  becoming  less  common  in  

developed  countries  these  days,  mainly  

due  to manufacturer reluctance to invest in 

reducing two-stroke emissions. 

Traditionally, two-stroke engines were 

reputed to need more maintenance Even 

though the simplest two-stroke engines have 

fewer moving parts, they could wear out 

faster than four-stroke engines. However 

fuel-injected two-strokes achieve better 

engine lubrication, also cooling and 

reliability should improve considerably 

 

COMMON FEATURES IN ALL TYPES  

There may be one or more pistons. Each 

piston is inside a cylinder, into which a gas 

is introduced, either already hot and under 

pressure (steam engine), or heated inside the 

cylinder either by ignition of a fuel air 

mixture (internal combustion engine) or by 

contact with a hot heat exchanger in the 

cylinder (Stirling engine). The hot gases 

expand, pushing the piston to the bottom of 

the cylinder. The piston is returned to the 

cylinder top (Top Dead Centre) either by a 

flywheel or the power from other pistons 

connected to the same shaft. In most types 

the expanded or "exhausted" gases are 

removed from the cylinder by this stroke. 

The exception is the Stirling engine, which 

repeatedly heats and cools the same sealed 

quantity of gas. In some designs the piston 

may be powered in both directions in the 

cylinder in which case it is said to be double 

acting. In all types the linear movement of 

the piston is converted to a rotating 

movement via a connecting rod and a 

crankshaft or by a swash plate. A flywheel is 

often used to ensure smooth rotation. The 

more cylinders a reciprocating engine has, 

generally, the more vibration-free 

(smoothly) it can operate. The power of a 

reciprocating engine is proportional to the 

volume of the combined pistons' 

displacement. 

  

A seal needs to be made between the sliding 

piston and the walls of the cylinder so that 

the high pressure gas above the piston does 

not leak past it and reduce the efficiency of 

the engine. This seal is provided by one or 

more piston rings. These are rings made of a 
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hard metal which are sprung into a circular 

groove in the piston head. The rings fit 

tightly in the groove and press against the 

cylinder wall to form a seal.  

 

APPLICATIONS  

The first successful application of the free-

piston engine concept was as air 

compressors. In these engines,  air  

compressor  cylinders  were  coupled  to  the  

moving  pistons,  often  in  a  multi-stage 

configuration. Some of these engines 

utilized the air remaining in the compressor 

cylinders to return the piston, thereby 

eliminating the need for a rebound device. 

Free-piston  air  compressors  were  in  use  

among  others  by  the  German  Navy,  and  

had  the advantages of high efficiency, 

compactness and low noise and vibration .  

Gas generators 

After the success of the free-piston air 

compressor, a number of industrial research 

groups started the development of free-

piston gas generators. In these engines there 

is no load device coupled to the engine 

itself, but the power is extracted from an 

exhaust turbine. (The only load for the 

engine is the supercharging of the inlet air.) 

  

A number of free-piston gas generators were 

developed, and such units were in 

widespread use in large-scale applications 

such as stationary and marine power plants. 

Attempts were made to use free piston gas 

generators for vehicle propulsion (e.g. in gas 

turbine locomotives) but without success.  

 

COATINGS 

Coating is a covering that is applied to an 

object. The aim of applying coatings is to 

improve surface properties of a bulk 

material usually referred to as a substrate. 

One can improve amongst others 

appearance, adhesion, wet ability, corrosion 

resistance, wear resistance, scratch 

resistance, etc. They may be applied as 

liquids, gases or solids. Coatings can be 

measured and tested for proper opacity and 

film thickness by using a Drawdown card.  

NANO COATING:  

Nano-coating is a recently developed 

technology used for coating any kind of 

material in hard coating and low friction 

coating both in which coating is done at 

nano scale that is of the order of 10-9  . The 

two major types of nano coating are  

1. Physical vapour deposition (PVD)  

2. Chemical vapour deposition (CVD)  

 

PHYSICAL VAPOUR DEPOSITION 

(PVD) 
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Thin film deposition is a process applied in 

the semiconductor industry to  

grow electronic materials and in the 

aerospace industry to form thermal and  

chemical barrier coatings to protect surfaces 

against corrosive environments and to 

modify surfaces to have the desired 

properties. The deposition process can be  

broadly  classified  into  physical  vapour  

deposition  (PVD)  and  chemical  vapour  

deposition  (CVD).  In  CVD, the  film  

growth  takes  place  at  high  temperatures,  

leading  to  the  formation  of  corrosive  

gaseous  products,  and  it  may  leave  

impurities in the film. The PVD process can 

be carried out at lower deposition  

temperatures and without corrosive 

products, but deposition rates are lower and  

it leaves residual compressive stress in the 

film. Electron beam physical vapour  

deposition, however, yields a high 

deposition rate from 0.1 μm / min to 100 μm 

/  

min at relatively low substrate temperatures, 

with very high material utilization  

efficiency.  

 

Parameters of PVD  

Deposition chamber vacuum pressure: 10-3   

tor No of electron guns: 6  

Accelerating voltage: 20kv-25kv  

Evaporation rate: 10-2 g/cm2sec 

 

RESULTS: 

1. Define the Type of Element 

Pre-processor > Element Type > 

Add/Edit/Delete > Solid 90 

2. Define Element Material Properties 

Pre-processor > Material Props > Material 

Models > Thermal > Conductivity > Isotropic  

3. Define Mesh Size 

Pre-processor > Meshing > Size Cntrls > 

Global >Set 

4. Mesh Volumes 

Pre-processor > Meshing > Mesh volume > 

Tet >Free Mesh >Pick all 

 

 

5. Define Analysis type 

Solution > Analysis Type >New Analysis > 

Type of Analysis > Thermal Analysis > Ok  

6. Obtaining Solution 

Solution >Solve >Current Ls >ok 
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The below steps followed for the Static 

Analysis 

 

1. Define the Type of Element 

Pre-processor > Element Type > 

Add/Edit/Delete > Solid 186 

2. Define Element Material Properties 

Pre-processor > Material Props > Material 

Models > Structural >Linear >Elastic 

>Isotropic 

Young’s Modulus and Poisson’s Ratio 

Pre-processor > Material Props > Material 

Models > Structural >Thermal expansion 

3. Define Mesh Size 

Pre-processor > Meshing > Size Cntrls > 

Global >Set 

4. Mesh Volumes 

Pre-processor > Meshing > Mesh volume > 

Tet >Free Mesh >Pick all 

5. Solution >Define Loads >apply 

>Structural >Displacement >fixed in all 

Dof’s 

 

 

 

6. Solution >Define Loads > Apply 

>Structural >Temperature >from Thermal 

Analysis.. Solution >Solve >current LS >ok 

 

CONCLUSION: 

 

A  finite  element  model  of  the  piston  

without  and  with  coating  layer  is created  

in  ANSYS  and  analyzed  in  the influence  

of  thermal  load  on  the  top surface of the 

piston 
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